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1 Introduction

This paper presents the results of the first stage of work on

developing a new tool for multimedia excavation reports,

using the Hypermedia system Microcosm.

2 Hypermedia in Archaeology

Archaeology is having to find ways in which to deal with

the information explosion that is a result of the develop-

ment of analytical techniques. The computer revolution

means that a large amount of the data generated by these

specialised analyses is now stored on computer. The

resulting problems of publication in archaeology are well

known: the sheer quantity of excavation data makes

complete publication virtually impossible, and the trend is

now towards summary publication with an accessible

archive.

The idea of using multimedia for archaeological

applications is not new. It has long been understood that

archaeology is a discipline which relies heavily on data

from a diversity of sources in a number of shapes and

formats. It is now recognised and accepted that archaeology

should take advantage of the possibilities offered by multi-

media. There have been attempts at resolving some of the

data management problems using novel technologies,

especially electronic storage, computer and multimedia

technology, for the publication of the more ‘unwieldy’

records generated by excavation: line drawings,

photographs, catalogues and tables (Rahtz et al. 1989).

The points in favour of using multimedia are summarised

and adopted here from Rahtz, Hall and Allen (1992: 360-

361):

– Much of the information in archaeology is very

specialised and full publication is not economically

viable, nevertheless data must remain accessible. Even if

it is not economically viable to publish material in a

conventional book which will only be read by a few

hundred people, some means of disseminating it is

required.

– Archaeology is a very data intensive discipline, both in

the field and also in the post-excavation process.

Computers can help with storage and access.

– The graphical representations already included in

conventional publications frequently present some

problems. Oversize drawings either have to be reduced,

with consequent loss of detail, or are included as fold-out

plans which are unwieldy and increase the cost of the

publication. There is already considerable use made of

graphical representations of the data (plans, drawings,

photographs, stratigraphic diagrams), none of which are

reproduced easily in a traditional book format.

– Whilst colour plays an important role as part of the

archaeological record for discrimination, it is hardly ever

used in publication. Ceramic thin-sectioning would be an

obvious example where the discipline would vastly

benefit from the ability to publish in colour.

– An important point is that the proportion of data held on

and generated by the computer in archaeology is growing

steadily. Virtually all but the very smallest excavations

now use databases to organise some aspect of their

archive. Many archaeologists already have large quan-

tities of machine readable data, and considerable

experience of formalising information.

– Finally, the results generated by new computer tech-

niques, such as GIS, now frequently used in archaeo-

logical research, are not suitable for publication on paper

and thus require new methods of publication. Multimedia

also provides an opportunity to publish data from the

excavation archive that has so far never been published,

such as colour photos or moving pictures.

Hypermedia should not be aiming to replace the book.

The basic assumptions by Rahtz et al. (1989: 20) in their

evaluation of the technology for archaeology state that we

will not be able to dismiss conventional books, as linear

narrative and argument have been the basis of scholarship

for millennia. The book has been the repository for past

knowledge, so any new form of representation must have

some kind of continuity with existing methods. Neverthe-

less, there is an opportunity to supplement the book in

certain areas of knowledge representation — especially

where arguments are supposedly backed up by reference to

the original data, this data should be freely accessible to

allow the assessment of the statement.

Anja C. Wolle A Tool for Multimedia Excavation Reports –
Stephen J. Shennan a prototype



A system is needed that can be added onto existing

practices, which is easily understood and does not require

complex mark-up languages or programming skills. The

current unpublished archives are artefacts of inadequate

technologies for disseminating archaeological information

— the time has come now to remove this stepping stone

and make the archives accessible. We are aiming to provide

an electronic archive with good access, which is directly

referenced back to the written report.

There have been attempts to use Hypermedia to provide a

new kind of excavation report, by producing hypermedia

publications of electronic books or archives. The problem

with most attempts so far is that they were developed using

monolithic packages and closed systems (such a Hyper-

Card). In a closed system the user is constrained to finding

and following the links made by an author. These usually

appear as highlighted text or graphics such as buttons.

These links frequently have to be explicitly defined one by

one by the author, thus making the authoring effort needed

for the compilation of such an application very labour-

intensive. Closed systems import the data and make it their

own, import or especially export facilities are relatively

unusual. Link definitions are frequently ‘hard-wired’ into

the data files; there is then no possibility to communicate

with other programs, or query the information in a way that

the author had not anticipated, as the data cannot be read by

other programs.

2.1 OPEN HYPERMEDIA AND MICROCOSM

Microcosm has attempted to overcome the problems of

closed systems. Since 1989 the Microcosm team has been

working on it and the third version has been released

(Davis et al. 1992c; Fountain et al. 1990; Hall et al. 1992;

Hill et al. 1992a). Microcosm is not just an authoring or

presentation system, it should be seen as an extension of an

operating system (Hall et al. 1992: 14), organising the

access to the documents. It consists of a message passing

system, which allows a number of autonomous processes

to communicate with each other. The information about the

links is held in a database separated from the document files.

This separation of links from the actual data files is an

advantage (Davis et al. 1992a), as it allows for far greater

flexibility. Files can be updated and accessed from applica-

tions that are not part of the hypermedia application itself.

A Microcosm (MCM) application comprises a set of

documents (individual files in the file system) that the

program knows about, together with a set of relationships

defined for those documents. MCM allows relationships to

be defined between objects and ideas in a variety of

document types such as text or graphics. The user is

provided with a core set of viewers; these are programs

which allow the viewing but not the editing of any files of

supported formats. These documents are prepared in various

software packages and viewed through the MCM viewers.

MCM also comes with a core set of filters. These are

programs which provide it with its information processing

and retrieval functionality. As it consists of a set of

independent programs which communicate with each other,

the functionality of these can be altered according to the

user’s requirements.

A minimum definition of an open system as used by

Microcosm is (Davis et al. 1992c: 6):

– A system which does not impose any mark-up on the

data which prevents it from being accessible to other

processes that do not belong to the system.

– A system which can integrate with any tool that runs

under the host operating system. Data produced by tools

that are not part of the hypermedia system may be used

within it without adding any special value to that data

and without compromising the continued use of the data

outside the system.

-– A system in which data and processes may be distributed

across a network, and across hardware platforms.

– A system in which there is no artificial distinction

between readers and authors.

– A system in which it is easy to add new functionality,

i.e. new program modules may simply be inserted.

An important way of accessing the documents inside

Microcosm is by following links. The system allows a

number of different actions to be taken on any selected item

of interest; links are specified either as buttons or invisible

links. A button simply binds two items of information

whereas the links can be of four different types:

Specific Links: specific links are similar to buttons,

however the link anchor is not highlighted.

Local Links: if a destination for a local link has been

defined in a document, the user can select the anchor

anywhere in the current document to follow the link.

Generic Links: The user can follow the link after

selecting the anchor in any document in the current

application.

Dynamic Links (Compute links): This allows the user to

follow links not explicitly defined by the author. The

available links will be calculated based on the anchor

selection anywhere in the application.

With the design of Microcosm the developers have also

tried to address the question of what users expect from a

hypermedia system (summarised in Davis et al. 1992b: 182),

which is also applicable to the archaeological environment:

– Users want a computer environment which is adaptable

for the integration of data, tools and services as required.

Users remain free to use whichever text editor or
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drawing package they prefer, without being bound to the

one provided for the particular hypermedia system.

By separating the links from the documents, this

independence has been maintained.

– To maximise exchange with other persons active in the

field, a system that is platform independent and allows

distribution across different platforms would be an

advantage. UNIX and Macintosh versions of Microcosm

are under development.

– A system that comes with powerful navigational aids to

allow the user (both the author and the reader) to find

and update the information without having to wade

through large amounts of irrelevant data. Text may be

pre-indexed (Li et al. 1992) to allow a general search of

text files. Other kinds of links also help to reduce the

authoring effort. A differentiation between public and

personal workspace and links is achieved by using

personal linkbases.

– Finally, a system in which all data types are treated in a

similar manner. If making links to data of one type of

package differs widely from the next package, the

learning will be more difficult and familiarity with the

more advanced features will progress more slowly.

3 A tool for Archaeology

It has to be accepted that nobody actually reads a complete

excavation report; they are clearly not designed to be read

from cover to cover. They are expected to give an overview

of the excavation and allow a fairly detailed view of the

data which the conclusions are derived from. However, with

the increasing trend towards summary publication all that

detail will be lost to the average reader by being kept in

the archives. These archives require extra effort for access

and in some respects are even worse than microfiche.

Excavation reports were supposed to be written with

specific reference to the data like a good index to the site.

If it is easier to access the data maybe people will change

their attitudes and consult and work with it more.

What is needed in archaeological publication is a tool

which will give access to the material in the excavation

archive for research. The computer can improve on access

and versatility and is a much more flexible tool than

microfiche. For example, images can be manipulated, their

brightness and contrast or colour maps can be altered

interactively to enhance special features of the image.

We have to stress here that this program will not be aiming

at the ‘public’ level of archaeology, but at research, which

will be able to make sense of the mass of fairly unrefined

data we propose to disseminate.

Initially we will be aiming at the excavators who have to

write up the paper report text. The new system will allow

them to organise their data and establish links between the

text and the supporting data. It is then possible to release

this electronic archive, probably on CD-ROM, on request.

This would be in addition to the conventional printed

volume, allowing researcher and readers access to the levels

of archive not usually accessible at all unless the archive is

visited. There are cases where archives can be split over

several locations, making access even more difficult.

We are not denying that there are instances where a visit is

essential, but generally it can help to disseminate more

archival information about a site.

One aim of the prototype is to remove from the user the

need to recognise the functions of each Microcosm 3.0 icon

by uniting them all into a toolbar. The toolbar is a relatively

simple program; it simply calls up individual Microcosm

3.0 components which can also be accessed directly from

their icons. The toolbar should reduce the user's confusion

about the 10 icons along the bottom of the screen. Obvious

components to be called are ‘show links’ or ‘open a

document’. Furthermore the archaeology toolbar will allow

users to integrate into Microcosm the other types of tools

now routinely used by many archaeologists such a Harris

matrix program, databases and spreadsheets. If all these

could be linked on a common identification such as the

context number, the data would become more useful.

4 Key study: the excavation at St Veit

Klinglberg

The excavation selected was carried out at St Veit Klingl-

berg (SVK) in Austria by Shennan in the summer seasons

of 1985-89. The site is situated in western Austria about

60 km south of the city of Salzburg. It lies between the

small towns of Schwarzach and St Johann im Pongau

(Shennan 1995).

The excavation archive is relatively small (approx. 1350

contexts), and only slightly stratified. A large part had

already been entered onto computer. The context, pottery

and botanical record were readily available as database

files. Finally all single context plans had been digitized with

AutoCAD (approx. 1360 files). Larger phase plans and site

plans were then compiled by amalgamating these plans.

The archive at the moment represents the excavation

report as submitted for publication, with the addition of the

complete database and illustrations archives.

4.1 PREPARATION OF THE ARCHIVE

As AutoCAD is a program that requires large resources of

computer memory and speed, and can behave sluggish at

the best of times, an alternative had to be found to present

the digitized plans and sections. It was decided to convert

them into DXF (data exchange format) files, as there is a

viewer for Microcosm under development that can access
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Figure 1. An example screen of Microcosm running with the sample data, showing a rich text document, a bitmap plan and the available links

that exist with regard to the selection made from the plan. Along the bottom the icons can be seen which represent the individual Microcosm

components. The Archaeology Toolbar is in the top left hand corner.

these files and block attributes if they are defined. The

multiple context plans have at the moment been scanned

from the publication drawings on a flatbed scanner due to

time constraints. Once the visualisation tool has been

developed all plans and sections are expected to be

available as DXF or AutoCAD files to build up a three-

dimensional visualisation of the excavation records.

The report text has been preserved in chapters and

appendices as written for the published report. As the

current objective of compiling this electronic archive is to

make available the existing archive, no attempt has been

made to make new arrangements for the text by splitting it

into smaller sections. The files were saved in rich text

format (RTF), which preserves their formatting and is used

to exchange word processor files between different

programs. As Microcosm 3.0 is supplied with a RTF

viewer, the formatting of the text could be maintained and

all footnotes were preserved as pop-up boxes. Tables and

Excel Charts were originally supplied as large Word for

Windows files; the chapter files contained both tables and

figures (Excel charts) grouped by chapter; these were

separated into individual files, named with the figure

numbers. This allowed the establishment of direct links and

the multiple display of tables or graphs for comparison and

made their management and labelling more straightforward.

The photographic excavation record and the smallfind

photos were digitised from slides and negatives using a

Nikon slide scanner. The resolution chosen was 635 dpi,

which will enlarge the slides to a size of 800*600; this

proved a satisfactory resolution for displaying them on

colour monitors. Further editing involved the sharpening of

the image and conversion from 24 bit (true colour) to 8 bit
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Figure 2. The Archaeology Toolbar prototype.

colour (256 colours) to reduce storage requirements. The

editing carried out involved some adjustment of brightness,

but essentially the aim was to preserve the details including

brightness of the slides as it was first captured in the field.

This means the multiple photographs of contexts were all

scanned, so that comparisons between different brightness

settings are possible. All files were converted to JPG's

which allowed a compression of 75 percent with minimal

loss of detail. The increase in display times is a necessary

and acceptable drawback, given the fact that the files are

now considerably smaller than the other format (Windows

BMP) that can be viewed with Microcosm 3.0.

4.2 ARRANGEMENT OF ARCHIVE WITHIN MICROCOSM 3.0

An example of running Microcosm with the digitized data

can be seen in figure 1, which shows a screen shot of the

Microcosm SVK application in action, showing multiple

windows of different document types.

To enter the files into the Microcosm application they

were dragged into the Select a document window. To

facilitate the organising of types, the following logical types

were defined:

– Report to include all textual material included in the

excavation report

– Figures to include all figures as referenced in the report,

including plans, sections and charts

– Sections to include all referenced sections, of which most

so far have been scanned rather than digitized

– Plans to include all referenced plans, of which most so

far have been scanned rather than digitized

– Finds to include all smallfind photos

– Slides to include all excavation slides

These classes will allow users to locate the material by type

at a glance. Some items will inevitably appear in more than

one class, as figures include sections and plans, as well as

tables and charts. The advantage of logical types is that the

files will not have to be duplicated on the hard disk and can

nevertheless be listed in more than one place.

4.3 ESTABLISHING LINKS AND DESCRIPTIONS

The main way of organizing the cross-referencing of the

documents was defined by context number; searches on

context numbers will reveal links to every reference to a

particular context number, in both text and image files.

For all bitmaps, named selections were defined on each

context number listed on these, with generic links anchored

on each of them. Sections and plans were treated in the

same way. Slides also have generic links ending on them

according to the context numbers represented on them.

A list of such links as displayed by Microcosm can be seen

in figure 1.
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The tool bar (fig. 2) gives the user a more straightfor-

ward interface of MCM. Rather than having to understand

the functions of the icons along the bottom of the screen

and having to double click on MCM to open the Select a

Document Window, it was decided to write a simple toolbar

front end which gives a button and menu interface that will

stay the same throughout. Direct access to certain core

documents which are pre-defined by the author is provided

as an entry point. Another key element to the usability is

the ease of preparation of the archive and therefore it is

desirable that the excavator should not have to specify links

by hand.

Microcosm is composed of many communicating

processes or components, allowing for different features or

services depending on which components are currently

active. This feature exists in keeping with the open

hypermedia philosophy. The communication between the

outside world and Microcosm is effected using Application

Programming Interface (API) used by Windows. Messages

are passed to Microcosm components to initiate actions.

The Visual Basic application uses API to communicate with

For the report text the computed links filter provided a

good mechanism for searching across all text files for the

occurrences of the relevant word. The user can select any

word and search in the created index for any matching

passages. However, this is only possible for text files and

may not be adequate for some kinds of searches. All author

names in the references were defined as generic links, as

were all figure numbers as mentioned in the text. Figures

were given descriptions containing both their original

numbers as used in the report and their descriptions as

copied from the captions.

5 Presenting it to the user – the toolbar

In our view Microcosm suffers from a slightly confusing

interface, presented by the 10 icons along the bottom which

all have different functions. As this is meant to be a system

for the casual and one-off user, it is important to make it

usable in moments rather than hours. Therefore the toolbar

unites the access to the icons in a group of menus and buttons

— to make it all more manageable and understandable.



Microcosm, to interrogate settings in the Registry, a central

file where all Microcosm settings and details of imported

documents are defined. In this way details about existing

documents can be accessed and specific documents can be

opened. Similarly individual components such as the Select

a Document window or the About box can be called up.

5.1 TOOL BAR FUNCTIONS (fig. 2)

In keeping with other Windows programs, the File menu

gives access to functions such as Open and Exit. It also

gives the option to open specific documents which the user

might want to access with ease. These were previously

specified in the registry. In this case the Contents and

References were defined as such fixed documents.

The Commands menu includes all Microcosm functions

such as compute links, show history and show links, which

connect to the functions of the Microcosm filters which

perform Compute Links, History and Show Available Links.

The Tools menu so far gives access to one simple

function called Change Titles which will organise the

re-naming of a list of documents contained within the same

directory. After the user has specified a directory, and

selected whether to change titles or types, the following

window will appear, giving the option to either skip the

current document, if no change is intended, or to type in a

new title or type and to change the document's record in the

Registry.

The Help menu currently points straight to the Micro-

cosm 3.0 help file which is executed using the windows

help program (winhelp.exe) as there should be very little

explanation necessary for the tool bar itself. The second

help option allows users to seek help for any specific key

word. The standard About box for Microcosm is also

included.

Finally, the buttons repeat selected menu functions,

adding ease of use and a visible reminder of available

commands.

6 Future options

The current version of the toolbar program provides a

simplified entry point to Microcosm for the user; it does

not provide any specifically archaeological tools such as

stratigraphic visualisation or data analysis modules, which

are the main aims of this project.

The setting up of applications should become far more

automated, so that the user only has to specify which files

to include, and possibly one additional text file which

contains the appropriate file descriptions. The program

would be able to complete the set-up and renaming of

documents by itself. The current facility for easing file

renaming after import is still very limited as it will only

examine a list of files contained in a directory, when it

might be advantageous to examine all documents imported

under a certain logical type.

Another important aspect that should be added is the

automatic linking. Currently it is possible to search for a

specific word using the ‘Compute Links' filter to search

text files. These automatic links will probably be defined on

file names or the file descriptions, which will then need

to contain the context number represented in the specific

image file for example.

Stratigraphic relationships are used extensively by the

excavator to understand the excavated site and material.

Stratigraphic relationships are identified which influence the

final interpretation of a site. It is thus crucial to allow the

user to centre the organization of the dataset around the

stratigraphic relationships rather than the report text as the

example application currently does. Possible approaches

would be to provide an extension of the program so that an

existing stratigraphic program can be used. Other data

visualisation tools that will allow users to examine site

reconstructions generated from the plans are the elements

which are needed to make the program uniquely archaeo-

logical. Possibilities include interactive find distribution

plotting from selected finds, projected directly onto a plan.

7 Conclusion

We hope that it has been shown that the use of open

hypermedia is the way forward for archaeology. It will

allow archaeology to deal with its data dissemination

problems.

The first experiments with Microcosm and the excavation

archive under consideration have shown that the proposed

tool is possible with existing technology. The materials

present in the excavation archive could be digitized satis-

factorily and proved to be suitable for electronic

representation. Microcosm provides a useful and flexible

framework for grouping the data within the excavation

report lay-out. Windows API with Visual Basic means that

most programs can be adapted to add the archaeological

functionality that distinguishes it as an archaeological tool.

It will now be necessary to add the specifically archaeologi-

cal analysis tools to the toolbar under development.

The tools which make the compilation of an electronic

excavation archive easier will also make it easier to re-

assess the excavator's conclusions. These days it is very

hard to do anything but take the excavator's report on trust.

In order to really examine an excavation report in depth

takes too much time and effort. Hypermedia excavation

report tools can make the excavator's argument much more

open to criticism and reassessment as specific details can be

found and examined more quickly. This may be uncom-

fortable for the excavators but is certainly important for the

discipline.
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